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Power Software Wiper
Introduction

 
 
Introduction

 
Power Software Wiper is a replacement for the standard Windows Add/Remove 
Software dialog. It loads fast and offers some additional features to remove leftover files 
and registry entries, as well as a forced uninstall mode for programs that did not come 
with a common uninstall tool. The program uses the original uninstaller first, and upon 
completion scans your registry and hard drive for any leftovers. It will then present you 
with a list of found items and you can choose to have them removed.  
 
Power Software Wiper provides powerful features to both beginners and experienced 
users. It offers you some simple but effective and powerful approaches to manage 
(uninstall, delete, disable from auto starting) and to get information about your installed 
and/or running applications. 
 
All the steps used by Power Software Wiper are done with simple clicks. You won't even 
notice the analysis process. Just share it now! 
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Power Software Wiper
Features

Features 
 

What the Power Software Wiper is and what you can do with it: 
 
 

●     Friendly and easy to use GUI.  

●     List all installed programs、system updates and screen savers quickly.

●     Backup the registry info of all installed program. 

●     Built-in Startup Item, take full control of Window startups. 

●     Add the comments for selected program in the registry.

●     Export any program uninstall information to reg file.

●     Displaying programs in 3 different views (Icons, List and Details). 

●     View all details of a certain application installed on your computer. 

●     Clean up remnants program files and reg keys after uninstalling.

 
●     Lighting speed at startup, 5-10 times faster than Add/Remove Program of Windows 

XP. 

●     Ability to uninstall screen savers.

●     Quickly open programs Install folder, Company site or support site.

●     Create a full report for the installed programs and save the report to a text file.

 
 
And more... 

 
 
 
 
So rather than wondering why your PC is running so sluggishly, just load up Power 
Software Wiper, an easy to use suite for uninstalling applications and keeping your 
computer clean.  
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Power Software Wiper
The user interface (Overview)

The user interface (Overview) 

 
 

 
 
 
 

Overview: When Power Software Wiper is started, the System Program List screen is 
the default screen. 
 
Navigation Panel: Including tabs of File, View, Tools, Help, Program List, Startup Item, 
you can navigate to other windows and dialog box just by clicking those tabs.  
 
Main area: Display the installed programs as well as some detail information.  
 
A: The descriptions  
 
B: The publisher  
 
C: The directory  
 
Note: Move the mouse onto a listed program , its size, frequency of use, dates of use, 
path of uninstall display automatically.  Page5



 
Quick Shortcuts panel :  Shortcuts to four functions of Power Software Wiper are 
displayed on the left of the panel 
 
Uninstall: Uninstall selected program .  
 
Show Details: Show details ( including Program Properties and Registry Values) of 
selected program  .  
 
Refresh: Refresh the current information of the program. 

Find Next: You can search certain installed application.

You can hide the system patch and Hide the screen saver at your will. 
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Power Software Wiper
File Menu

Add a New Program 

 
 

You are able to add a new program in your computer at your will.  
 
The following steps describe how to add a new program:  
 

Step 1: Click the File button on the toolbar, the following list will display

 

Step 2: Click the the "New Program" to open the Windows Run dialog.  
 

Step 3: Type the name of a program, or click Browse button to select the setup 
file, then click Confirm, windows will open it for you. 

Registry Information

A: You can choose the program and export the registry information, by clicking 
Export Registry Info.

B: Reload the registry information from a reg file. 

C: Backup the registry information of the whole software installed. 

Drop down the mouse and click the Create Backup, it will back up the registry 
information of all installed program under the installed folder(\Back up\reg) . 

Resume the deleted screen saver, you can recover it from installed folder\back up\*.
scr to C:\Windows\System32\dllcache. 

Export Program List
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Select the Export Program List, you can see a following dialog: 

Create a full report for the installed programs and save the report to a text file or 
print it (installed printer Required). 

Other Using: 

View and Tools Menu

Quick Shortcuts Panel

Main Area of Power Software Wiper

Set The Startup Item

Uninstalling Programs
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Power Software Wiper
View and Tools Menu

 
Under the View menu, you can view the Listed program with appropriate icons. Tick the 
Tips show the tips of the program as pointing to the listed program. 

Under the Tools menu, the following operation you can execute for the program. 

Step 1: Add the comments for selected program in the registry. 

Step 2: click the Registry editor to edit the registry information, then a REGEDIT box 
will display, Just edit in it. 

Step 3: Select the Windows Update to update your windows, add a new windows 
function and a process of equipment of drive. 
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Step 4: Select the Windows Services, then you will see the services details legibly, and 
suspend, pause, start up the services at your will.
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Step 5: Achieve your order to add or remove the components by entering the Windows 
components. 
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On the right of main toolbar, there are two button for Switching to the Program List from 
Startup Item.

 
Other Using:

File Menu

Quick Shortcuts Panel

Main Area of Power Software Wiper

Set The Startup Item

Uninstalling Programs
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Power Software Wiper
Quick Shortcuts Panel

Quick Shortcuts Panel

Shortcuts to four functions of Power Software Wiper are displayed on the right of the 
panel. 

●     Select a program you want to uninstall, then click the 

. The program will be uninstalled completely 
according to your order.

●     The detail information box allows you to view details (including Program Properties 
and Registry Values) of a selected program. If you want information of another 
program, just select it in the Program option box instead of selecting it in the 
Program List. 

 
●     Refresh your current program list. 
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●     Search: Powerful search feature allows you to find out the program you are about 

to uninstall quickly.

●     Hide System Patch allows you to hide the patch in the listed program
 
●     Hide the Screen Saver allows you to hide the screen saver installed in your 

computer.

Other Using:

File Menu

View and Tools Menu

Main Area of Power Software Wiper

Set The Startup Item

Uninstalling Programs
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Power Software Wiper
Main Area of Power Software Wiper

Programs list

Contains the programs and the program patch overview, it shows some information 
about them. You can gain much more details according to the following operation. 

Step 1: Right click a program ,you will see a menu like this: 

Step 2:Move the mouse on a program, then click the  to 
uninstall the program as well as its files, folders completely. 

Step 3: Add the comments for the program you selected as you enter the Comment 
Entry.

Step 4:Click the Registry editor to edit the registry information , then it will display a 
REEDIT. Just edit in it.

Step 5:Click Export Registry Info to export the registry information, 
Page15



Step 6: Show details of the program which you choose, including Program Properties 
and Registry Values, if you need to see another program information, just work it in the 
Program option in this dialog box do without choosing it in the Program List.

Step 7: Displaying programs in three different views (Icons, List and Details). 

Step 8: You can open the folder of the program when you click the hyperlink listed in 
directory. 

 
Other Using:

File Menu

View and Tools Menu

Quick Shortcuts Panel

Set The Startup Item 

Uninstalling Programs
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Power Software Wiper
Uninstalling Programs

To uninstall a program: 

 
 

1 – Select the program you want to uninstall 

2 – Click Uninstall button from the quick shortcut on the left panel. Double click or right click the 
program you want to uninstall.  
 
After clicking the Uninstall, the following uninstall dialog will be displayed. 

 

Click Yes to uninstall the program or click No to cancel . If you click Yes, Power Software Wiper 
will open the following warning. 

Click Yes to uninstall the remain files or click No to cancel, if you clicked Yes, the following box will 
pop-up.
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If the program isn't uninstalled completely from your computer , the Scan Remains dialog will 
display all left files, folders and registry keys. Just click Delete to uninstall the remains 
completely. Click Cancel to terminate the operation. 

If the program is uninstalled successfully from your computer, the following box will pop-up. 
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Click OK  to close uninstall dialog and return to Main Window.

 

Other Using: 

File Menu

View and Tools Menu

Quick Shortcuts Panel

Main Area of Power Software Wiper

Set The Startup Item
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Power Software Wiper
Set The Startup Item

Startup Item

Switch to the Program List between Startup Item by clicking the two button.

Some items on the main area are listed in the startup Item. If you want to run or forbid 
the item as the computer start up, you can set it at your will.

 

Item information

 Select a item and Scan the item information  including the publisher, version and 
description, which will be displayed on the left panel of the main area. 

Add Entry

Select a program, drop down the mouse and click the Add Entry, it will show the Add Item 
dialog like this:

Page20



Type the program name or click Browse to select the program you want to add, there are 
four different ways of windows start up the program in the Section for your choose:

A: Startup Folder\Current User: Add the link of the programs to the startup folder, it will 
be started by windows automatically.

B: Startup Folder\All User: Add the link of the programs to the startup folder, it will be 
started by windows automatically no matter the identity of the user. 

C: Registry\Current User\Run: Add a key under HKEY_CURRENT_USER\Software\Microsoft
\Windows\CurrentVersion\Run, then it will run as windows startup.

D: Registry\All User\Run: Add a key under HKEY_LOCAL_MACHINE\Software\Microsoft
\Windows\CurrentVersion\Run, then it will run as windows startup. 

Click Ok to finish or cancel it. 

Disable All or Enable All

Disable all the items to run as the computer startup.

Enable all the items to run as the computer startup. 

Delete the selected item 

If an unnecessary item is listed in , you can delete it from the list.

Apply the settings

Any change in the item list will not be saved if you forget to save the settings by clicking 
Apply. 

 
 
Other Using Process:

File Menu Page21



View and Tools Menu

Quick Shortcuts Panel

Main Area of Power Software Wiper

Uninstalling Programs
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Power Software Wiper
Question Icon

Question Icon

The Question Icon  shows other information about Power Software Wiper. 
Click this icon, you will see the following window: 

 
Help Content: Click this button or the Key "F1"(it works anywhere in the program), 
and a detailed help page about Power Software Wiper will open. .  
Language: choose the language . 
Registry :Guide to the  registration window.  
Enter Serial Number: Enter the registration key to switch the trial version into full 
version.  
Online Resources: Link to WindowsSupporter Website .  
Contact Technical Support: Contact our Support Team.  
About: Show the information of this software.  
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Power Software Wiper
About Windows Supporter

About Windows Supporter

Be the top Guard of Windows!  
 
 
Being a shareware developer of Windows Operating System solutions, Windows 
Supporter take the lead in this domain. We have professional experience in execute 
our faith - Think as A Customer. This gives us the idea to create reliable and simple-
in-use software products for you.  
 
Windows Supporter R&D Center creates simple solutions to complicated problems. 
And sleek, clear interfaces in our accomplishment make everything you need from 
us being enjoyable. 
 
Contact Us 
 
For Customers 
Email: 
English: support@windowssupporter.com 
French: support_fr@windowssupporter.com 
German: support_de@windowssupporter.com 
Tel:  
+1 952 646-5022 (for calls from outside the U.S.)  
+1,800,406 4966 (for calls from inside the U.S.) 
Power Software Wiper 
Product ID: 300180014 

 
We always do our best to answer your question! 
 
For Partners 
North America: 
sales@windowssupporter.com 
We benefit together with our partners in a win-win model - the Windows Supporter 
Business Model, and we love to talk about our creations with you. 
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Power Software Wiper
FAQs

FAQs

Q: How to disable/enable an application from auto start?  
 
A: You only have to remove the check mark in front the application you want to 
disable from Startup Item when Windows starts. And conversely to enable it put a 
check and it is enabled.  
 

Q: How to uninstall an application with Power Software Wiper?  
 
A: In Uninstaller there are three ways. Select the application in the list and press 
"Uninstall" button in the quick shortcut panel on the left , double click or press right 
mouse button over the application in the list and select "Uninstall" command.  
 

Q: How to search the installed application?  
 
A: On the left of main area, there are a quick shortcut panel, you just type the 
program name you want to search, then click the Find Next button. 

 Q: How to change View type? 

A: From the uninstaller toolbar you can change the view of the list of applications. 
You have to use drop down button and click on the little arrow on its right side, 
which will show you the menu with all list view options - Icon, List and Report. Other 
faster and simple way to change that view is by just clicking on the View button. 

Q: How to backup the registry information of the installed program?

A: Enter the File menu, just click the Create Backup, then it will backup your registry 
information of the installed program automatically. 

Q: How to enter the location of installed program?

A: In the program list, there are the directory of the program, just click the 
hyperlink, then it will open the folders. 

Q: How to export the programs list?

A: Enter the File menu, drop down to the Export Programs List, click it, then you can 
save and print the program list. 
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Power Software Wiper
How to buy Power Software Wiper

How to buy Power Software Wiper

As soon as you make your order, our resellers will verify it. Your order will most 
likely be processed within less than 1 hour, but in some VERY rare cases it may 
take resellers more than 24 hours to process your payment.  
 
The registration key will be automatically generated at our server and e-mailed to 
you immediately after we receive payment confirmation from our e-commerce 
reseller.  
 
Please do not worry if you haven't received the registration information right away. 
Delays usually occur due to the high security settings of spam filters used by our 
clients. Our message may be rejected as a spam message by the mail service you 
use. 
 
 
If you haven't got the registration message in several hours, feel free to contact 
our Support Teamvia email.  
 
If you have questions concerning our software, please send e-mail to: 
support@windowssupporter.com. We always do our best to help you!

Why Power Software Wiper?

Save Time 
a. It is outstanding in high-speed; 
b. The easy-in-use interface reduces your time in learning; 
 

 
Save Money

a. It is one-way ticket you have to buy in fixing all your registry 
problems; 
b. Guarantee 30-days-money-back if you are unsatisfied with it! 
 

 
Easy-in-use 

It is easy to use and fast in speed, With step-by-step manual, no matter an 
experienced user or a beginner you are, the software will make the task of 
optimizing your system a breeze! 
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What will you have after purchase?

Full version of Power Software Wiper 
There would no limit in its functions, and you could have fun in unlimited 
system optimizing. 

 
Lifetime license  

When you purchase Power Software Wiper, you get free online upgrades on 
the main version with Lifetime Upgrade Policy. 

 
Customer care 

We are pleased to offer our care to meet your needs. We promise our 
customers, any customer question will be satisfied within 1 business day! 

 
Coupons for WindowsSupporter products in Discount Center 

We prepared a series of benefits for our customers.
 

Is my order secure?

We promise the most secure purchase as we did for years. 
ShareIt and RegNow, all these WindowsSupporter partners passed strict 
certification. We truly believe in 'Only by benefiting our customers can we benefit 
ourselves'.. So your purchase security in WindowsSupporter is one of the top affairs 
we care about! WindowsSupporter has been involved in E-commerce for years. And 
through these years, we built up a secure online shopping system. You can enjoy 
the high-speed and convenience we offer. 
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